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1. TEDS IEEE 1451.4 INTRODUCTION
The DPM-3 is a TEDS IEEE 1451.4 Plug and Play Smart Load Cell Meter. TEDS, or
Transducer Electronic Data Sheet, is a set of electronic data in a standardized format
defined within the IEEE 1451.4 standard. Stored in an EEPROM, this data specifies what
type of sensor is present, describes its interface, and gives technical information such as
sensitivity, bridge type, excitation, etc.
The DPM-3 automatically detects when a TEDS IEEE 1451.4 compliant Load Cell / Torque
Sensor has been connected to it by using a built-in EEPROM detector. Once such a sensor
has been detected, the DPM-3 displays a front panel TEDS indicator light, reads the
EEPROM, stores the information in memory, and performs an automatic configuration. The
built-in, sensor-related EEPROM may be of any of the following types: DS1973/DS2433,
DS2431 or DS1971/DS2430A. The automatic system configuration function performs all
steps needed to calibrate the TEDS IEEE 1451.4 compliant Load Cell / Torque Sensor and
DPM-3 as a system. This includes the configured precision of 32 bits, 19 bits or 11 bits and
the configured excitation voltage. Using the DPM-3 with a TEDS IEEE 1451.4 compliant
Load Cell / Torque Sensor is as easy as plugging a mouse into a computer, making it a true
plug and play experience.
The DPM-3 is safety certified to UL 61010-1 and to CSA C22.2#61010-1. It carries the ETL
certification mark for the USA and Canada.

2. GENERAL INTRODUCTION
DPM-3 digital panel meters are a versatile, cost-effective solution to a wide variety of
monitoring and control applications. They are easily set up to produce an accurate display
of weight, load or direct reading of microvolts. Setup can be via front panel pushbuttons or
the meter’s serial interface. Digital scaling of zero and span provides direct readout in engineering units. Digital calibration of all ranges eliminates drift associated with potentiometers
found in non-microcomputer-based meters. Selective security lockout of the front panel keys
protects against accidental changes to the meter setup.
A unique method of analog-to-digital conversion provides 60 conversions per second (50 for
50 Hz operation), while integrating the signal over a full line cycle for maximum noise
rejection. Self-calibration cycles reduce the average reading rate to 56 per second (47 for
50 Hz). This fast read rate provides an accurate display of peak signal input and quick
response in control applications.
An adaptive auto-filter automatically selects a time constant appropriate for the encountered
signal noise level. This ensures stable displayed readings and outputs while responding
rapidly to changes of the input signal that exceed a selected threshold value. Input signal
polarity may be selected as normal or reverse.
The DPM-3 uses a lightweight, high-efficiency switching power supply that operates from
either AC or DC voltages and complies with safety regulations. The meter can be powered
worldwide without changes to the supply. An optional low voltage supply operates on 10 to
48 Vdc from batteries or 12 to 32 Vac from sources such as 400 Hz aircraft power. Both
supplies have an isolated 10 Vdc excitation supply to power transducers.
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The NEMA-4 (IP65) 1/8 DIN case is made of high impact 94V-0 UL-rated plastic. Mounting
is from the front of the panel and requires less than 110 mm behind the panel. All wiring is
by removable plugs conforming to UL61010C safety standards. All output options are
isolated from meter and power ground by 250 Vac minimum.
Alarm or setpoint control is provided by an optional relay board with two or four Form C 8A
mechanical relays or two or four Form A 120 mA solid state relays. The setpoints may be
latching or non-latching, be energized above or below the setpoint, or operate in a fail-safe
mode. The relays can operate from the filtered signal to reduce relay chatter or from the
unfiltered signal for fastest response. Snubber circuits and a programmable relay switching
time delay extend relay contact life.
An isolated analog output of 4-20 mA, 0-20 mA, 0-10V or -10 to +10V can be provided by an
optional analog output board. The output is linearized to the display and can operate from
the filtered or unfiltered signal input. It can be scaled via front panel pushbuttons or the
meter’s serial interface.
Optional RS232, RS485, or USB serial interfaces allow the DPM-3 to communicate bidirectionally with computers, PLC’s or other digital devices. An optional USB-to-RS485 converter
board allows a primary DPM-3 to be interfaced to a computer and to be the device server for
a network of up to 31 other DPM-3’s on an RS485 bus, while itself retaining all capabilities
of a meter.
Windows-based software is available from Transducer Techniques to program our meter
and transmitters via a PC using the serial interface. This software can be downloaded at no
charge from www.transducertechniques.com/online-manuals.aspx. Please see Section 19
for details.

3. RECEIVING & UNPACKING
Your DPM-3 meter was carefully tested and inspected prior to shipment. Should the meter
be damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return the unit to Transducer Techniques for
repair or replacement. Please include a detailed description of the problem.

4. SAFETY CONSIDERATIONS
Visually inspect the instrument for signs of damage. If damaged, do not attempt to operate.
Warning: Use of this equipment in a manner other than specified may impair the protection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.
Caution:
This unit must be powered with AC (mains) from 85-264 Vac with the high voltage power
supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power supply option. Verify
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that the proper power option is installed for the power to be used. This meter has no AC
(mains) switch. It will be in operation as soon as power is connected.
The 85-264 Vac mains connector (P1 Pins 1-3) is colored Green to differentiate it from
other input and output connectors. The 12-32 Vac (10-48 Vdc) mains connector is colored
Black.
Do not make signal wiring changes or connections when power is applied to the instrument. Make signal connections before power is applied. If reconnection is required,
disconnect the AC (mains) power before such wiring is attempted.
To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.
Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard.
This meter is designed to be mounted in a metal panel. Verify the panel cutout dimensions, and mount according to instructions.
Symbols applicable to this product:

ETL Mark. Indicates that product conforms to UL Std. 61010-1 and is certified
to CAN/USA Std. C22.2 No. 61010-1
4006497

CE Mark. Indicates that product meets EU safety, health and environmental
requirements.
Caution (refer to accompanying documents)
Caution, risk of electric shock.
Earth (ground) terminal.
Equipment protected throughout by double insulation or reinforced insulation.
Both direct and alternating current.
RoHS Symbol. Indicates that product is free from hazardous substances defined
in EC directive 2002/95/EC.
WEEE Symbol. Indicates that product should be recycled and not disposed of as
general waste.
Operating environment:
The meter is Class II (double insulated) equipment designed for use in Pollution degree 2.
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5. CONNECTOR WIRING INFORMATION
5.1 CONNECTOR LOCATION
Connectors for signal and power are UL-rated screw-clamp terminal blocks that plug into
mating jacks on the printed circuit board. Communication connectors can be a USB jack, a
single RJ11 jack for RS232, dual RJ11 jacks for RS485, or dual RJ45 jacks for RS485.

Note: For wiring color, refer to Load Cell Calibration Certificate or to
www.transducertechniques.com/wiring-color-code.aspx
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P3 - SERIAL COMMUNICATIONS

RS232 INTERFACE
N/C
ISO GND
RX
TX
RTS
N/C

6
5
4
3
2
1

P4 - ANALOG OUTPUT

Computer
GND
TX
RX
RTS

RS485 INTERFACE - FULL DUPLEX
ISO GND
BRX
ARX
ATX
BTX
ISO GND

GND
BTX
ATX
ARX
ARX
GND

6
5
4
3
2
1

RS485 INTERFACE - HALF DUPLEX
ISO GND
ATX / ARX
BTX / BRX
ISO GND

RS485-MODBUS - FULL DUPLEX
(A') RXD0
(B') RXD1
(B) TXD1
(A) TXD0
ISO GND

1
2
3
4
5
6
7
8

GND

6
5
4
3
2
1

ATX / ARX
BTX / BRX
GND

RS485-MODBUS - HALF DUPLEX

TXD0
TXD1
RXD1
RXD0

(B) TX/RXD1
(A) TX/RXD0

GND

ISO GND
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1
2
3
4
5
6
7
8

D1
D0
GND

6. MECHANICAL ASSEMBLY
REMOVING THE REAR PANEL
First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.
Retaining tab
with tab release

Retaining tab
with tab release

Retaining tab

Retaining tab

Rear Panel
REMOVING THE ELECTRONICS
With the rear panel removed, grasp the power supply board to the left and signal conditioner board to the right, and carefully slide the electronic assembly out through the rear of
the case (see figure below).

INSTALLING NEW OPTION BOARDS
Options boards plug into the main board at the front of the meter. These are plug-and-play
and may installed in the field. They will be recognized by the software, which will provide
access to the menu items associated with that board. If necessary, remove rear panel
knockouts for new boards. Boards plug into connectors as follows:
Option Board
Power supply
Relay board
Serial interface board
Analog output board
Signal conditioner board

Main Board Jack

Rear Panel Jack

P11
P12
P13
P14
P15

J1
J2
J3
J4
J5
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Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of
the main board and option board are aligned.
REASSEMBLING YOUR METER
Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, then carefully align
the board connectors with the openings in the rear panel. If necessary, remove any rear
panel knockouts for new option boards that may have been installed. Ensure that all option
boards are properly aligned with the molded board retaining pins on the inside of the rear
panel. With the rear panel in place, reinstall the input/output screw clamp terminal plugs.
PANEL MOUNTING
Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the
two mounting screws counterclockwise until the space between the mounting pawl and the
rear of the gasket is greater than the panel thickness. Insert the meter in the panel cutout.
Turn the mounting screws clockwise until the meter is securely mounted in the panel. Do
not overtighten.

The DPM-3 uses UL / VDE rated detachable
screw terminal connectors for signal and power.
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7. FRONT PANEL INDICATORS AND SETUP KEYS

Instrument
Calibration
indicator
(Reverse
Alarms menu)
status

Sensor Calibration
indicator
TEDS indicator

indicators
1 through 4

Alarms key
(Reverse menu)

Menu key
Peak display key
(Digit select)

Reset/Tare key
(Value select)
Meter Front Panel

TEDS INDICATOR
On steady when DPM-3 has detected a TEDS sensor, has read the EEPROM, and has
performed an automatic meter configuration.
CALIBRATION INDICATORS
The following two indicators are active when the Calibration indicators are enabled by the
tArE menu item:
1. INSTRUMENT CALIBRATION INDICATOR
Flashing indicates either that the instrument is due for calibration or will be due in less
than 30 days. On steady when instrument is past due for calibration. Stops flashing when
acknowledged from the front panel by selecting the CALrt menu item and changing the
first digit from a 1 to a 0.
2. SENSOR CALIBRATION INDICATOR
Active when a TEDS Plug-and-Play Sensor is detected in Plug-and-Play mode, otherwise stays dark. Flashing indicates either that the sensor is due for calibration or will be
due in less than 30 days. Stops flashing when acknowledged from the front panel by
selecting the CALrt menu item and changing the second digit from a 1 to a 0. Once
acknowledged, it is on steady when the TEDS Plug-and-Play sensor is past due for
calibration.
FRONT PANEL KEYS
There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols (
Menu,
Digit select,
Value select,
Reverse menu) for the Menu Mode.
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KEYS IN MENU MODE
In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.
(Menu). Pressing MENU steps the meter through all menu items that have been
enabled and then back to the Run Mode. With the DC signal conditioner board and no
option boards, available menu items are _InPut, SEtuP, ConFG, _FiLtr, dEc.Pt, Lo in,
Lo rd, Hi in, Hi rd, tArE, Loc 1, Loc 2, Loc 3, Loc 4 . If a change has been made to a
menu item, that change is saved to non-volatile memory when the MENU key is
pressed next, and StorE is displayed briefly.
(Digit Select). Pressing digit select from the InPut menu brings up all meter functions
available with the meter's signal conditioner. For the Load cell signal conditioner, these
are, Strn and _dC u.
Pressing digit select from the SEtuP, ConfFG, FiLtr, Lo in, Lo rd, Hi in, Hi rd, tArE,
Loc 1, Loc 2 or Loc 3 menus items sequentially selects digit positions 1 - 5, as
indicated by a flashing digit: 00000, 00000, 00000, 00000, 00000.
(Value Select). Pressing value select for a flashing item (digit position or decimal point
position) will increment that item. Pressing MENU will save any changes.
(Reverse Menu). Pressing
has the same effect as the MENU key, except that menu
items are brought up in reverse order.
KEYS IN RUN MODE
MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.
PEAK Key. Pressing PEAK normally causes the peak value of the input signal to be
displayed. The peak display then blinks to differentiate it from the normal present value
display. Pressing PEAK again returns the display to the present value. The PEAK key
can also be programmed to display Valley, alternating Peak or Valley, or to Tare the
reading to zero. When Peak or Valley is selected, periodic horizontal bars at the top of
the display indicate Peak, and periodic horizontal bars at the bottom indicate Valley.
RESET/TARE Key. Pressing RESET with PEAK resets peak and valley values.
Pressing RESET with ALARMS resets latched alarms. Pressing RESET with MENU
performs a meter reset (same as power on). Meter reset can also be applied via a rear
panel connector. Pressing and releasing RESET/TARE tares the meter value to zero.
ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.
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8. ENABLING & LOCKING OUT MENU ITEMS
For security reasons and ease of meter operation, any or all menu
items may be disabled or "locked out" so that they are no longer
accessible from the front panel. Each function to be disabled can be set
to "1" under menu headers Loc 1-4, while each function to be enabled
can be set to "0." Access to the menu headers Loc 1-4 can in turn be
locked out by installing a hardware jumper on the power supply board.
With the jumper installed, the operator only has access to previously
enabled menu items, not to the menu headers Loc 1-4 and hence not to
the menu items below. With the jumper removed, the operator has
access to menu headers Loc 1-4 and hence to the menu items below.
Check lockout status. DPM-3 meters may have lockouts in place. This causes
menu items described in this manual not to appear.
SETTING HARDWARE LOCKOUT JUMPER
To access the lockout jumper, remove the rear
panel per Section 6 and locate jumper “a” in the
lower portion of the power supply board next to the
input connectors (see figure above).
SETTING SOFTWARE LOCKOUTS
When setting up the meter, it may be necessary to
enable specific menu items by setting the corresponding lockout digit to 0. Be sure to reset the
lockout digit to "1" if you do not want the menu item
to be changed by an operator.
Loc 1 Loc 2 Loc 3 Loc 4
Press the MENU key until Loc 1, Loc 2 Loc 3 or Loc
4 is displayed. Note: Hardware lockout jumper “a”
must be removed (see above).
11111
Press the PEAK to display the lockout status, consisting of 1’s and 0’s. The left digit will flash. Press
again to step to the next digit, which will flash.
00000
12345
Press RESET to set the flashing digit to "0" to
enable the menu item or to "1" to disable. Press
MENU to enter. See the table to the right for list of
menu items that can be enabled or disabled.
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Enabled or Disabled Menu Items
Loc 1
1 - Input type selection.
2 - Meter setup, configuration &
decimal point
3 - Filter selection.
4 - Scale or Lo, Hi input.
5 - Offset or Lo, Hi reading
Loc 2
2 - Alarm setup.
3 - Alarm setpoint value
programming.
4 - Analog output scaling.
5 - Serial interface setup.
Loc 3
2 - View peak value
3 - View alarm setpoints
4 - Reset (peak & latched alarms)
5 - Reset (meter reset)
Loc 4 (TEDS only)
1 - dAte
2 – Serial number of meter & Units
3 - Calibration dates and CALrt
4 - Calibrator’s initials & bridge ID
5 - Calibration Period

9. TEDS SIGNAL CONDITIONER IN TEDS MODE
9.1 INTRODUCTION
The DPM-3 is a TEDS IEEE 1451.4 Plug and Play Smart Load Cell Meter. TEDS, or
Transducer Electronic Data Sheet, is a set of electronic data in a standardized format
defined within the IEEE 1451.4 standard that is stored in an EEPROM. This data specifies
what type of sensor is present, describes its interface, and gives technical information such
as sensitivity, bridge type, excitation, etc. The DPM-3 will automatically detect when a
TEDS IEEE 1451.4 compliant Load Cell / Torque Sensor is connected to it, each and every
time, by a built in EEPROM detector. Once a TEDS Sensor has been detected, the DPM-3
displays a front panel TEDS indicator light, reads the EEPROM and stores the information
in memory and performs an automatic configuration. The automatic system configuration
function performs all steps needed to calibrate the TEDS IEEE 1451.4 compliant Load Cell
/ Torque Sensor and DPM-3 as a system, including selecting the correct sensor excitation.
Using the DPM-3 with a TEDS IEEE 1451.4 compliant Load Cell / Torque Sensor is as
easy as plugging a mouse into a computer, making it a true plug and play experience.
9.2 SCALING
When a DPM-3 connected to a TEDS transducer is powered on, the meter reads the data
stored in the transducer. The excitation supply is automatically set to the correct value and
the DPM-3 calculates the correct scaling to calibrate the meter and the transducer as a
system. The jumper on the signal conditioner board must be set for the 50 mV range. See
Section 13.1. If the Maximum Physical Value of the TEDS sensor exceeds 100,000, the
calculated scale and offset are divided by 10 and the reading is in 10's of units.
If the full scale of the transducer is 50 pounds, the meter will display 50 at full scale output.
If more resolution is desired, the meter decimal point can be set so that the meter will read
50.0, 50.00, or 50.000. In this example, if another unit of measure, such as kilograms, is
desired, there are two alternatives.
If the meter has a serial communication board installed, TEDS Reader_Editor software
can be used (see Section 24 "Accessories" for information). The electronic data sheet for
your transducer can then be read electronically and be displayed on a computer screen.
The values can be modified (e.g., to display kilograms instead of pounds), and then written
back to the transducer.
The meter Menu item "Tare," digits 4 and 5, can be set to 1 to configure the meter as a
non-TEDS transducer type.
9.3 Error Messages
If there is a problem with the TEDS connection between the meter and the TEDS transducer, one of the following error messages will be displayed at power on or when plugging
in a TEDS transducer while the power is on:
Err 1
Err 2
Err 3
Err 4
Err 5

-

TEDS data line shorted
No Presence pulse from TEDS
Improper Presence pulse width
TEDS family code in ROM in error
TEDS checksum error in the first or second 32 bytes
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9.4 Software
TEDS Reader-Editor Software, P/N DPM-3-TRES, is available from Transducer Techniques. This software allows the user to read and edit information stored in the TEDS
transducer. See Section 24 "Accessories" for ordering information.
9.5 Meter Setup
When setting up the meter, it may be necessary to enable some of the menu items.
See Section 8 “Enabling and Locking Out Menu Items” for the procedure.
MENU
KEY

SEtuP
Meter Setup

ConFG
Meter
Configuration

DIGIT
SELECT KEY

VALUE
SELECT KEY

_0__0
Power line frequency

0 Noise minimized for 60 Hz
1 Noise minimized for 50 Hz

_0__0
Rear control inputs
A&B
True = logic 1 (0V or
tied to digital ground)
False = logic 0 (5V or
open)

0
1
2
3
4
5
6

_00___
Operation of front panel
PEAK button

0 Peak Display (max reading)
1 Valley Display (min reading)
2 Peak (1st push), Valley (2nd push)

_00___
Signal polarity

0 Normal Input Signal Polarity
1 Reverse Signal Polarity

A = Reset,
B = Meter Hold
A = Function Reset B = Peak or Valley Displ.
A = Meter Hold
B = Peak or Valley Displ.
A = Meter Hold
B = Tare
A = Peak or Valley B = Tare
A = Tare
B = Reset
A = 0, B = 0, decimal point 1= XXXXX
A = 1, B = 0, decimal point 1 = XXXX.X
A = 0, B = 1, decimal point 1 = XXX.XX
A = 1, B = 1, decimal point 1 = XX.XXX
7 A = 0, B = 0, decimal point 2 = XXXX.X
A = 1, B = 0, decimal point 2 = XXX.XX
A = 0, B = 1, decimal point 2 = XX.XXX
A = 1, B = 1, decimal point 2 = X.XXX.X
8 A = Function Reset B = Display Blank
9 A = Hold
B = Display Blank
A A = Peak or Valley B = Display Blank
B A = Tare
B = Display Blank
C A = Valley Display B = Peak Display
D A = Tare
B = Tare Reset
Both control inputs A and B set to logic 1 for
selections 2, 4, A, C = Function Reset.
Both control inputs A and B set to logic 1 for
selections 0, 1, 3, 5, 8, 9, B, D = Meter Reset.
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MENU
KEY

FiLtr
Filtering

dEc.Pt
Decimal point
selection.

DIGIT
SELECT KEY

VALUE
SELECT KEY

00000
Alarm filtering

0 Alarm unfiltered
1 Alarm filtered

00000
Peak & Valley filtering

0 Peak & Valley unfiltered
1 Peak & Valley filtered

00000
Display filtering

0 Display batch average every 16 readings
1 Display filtered signal

00000
Adaptive filter threshold

0 Low adaptive filter threshold level
1 High adaptive filter threshold level

00000
Input signal filtering.
Can be applied to display, setpoint, analog
output, data output.

0 Autofilter
1 Batch average, 16 readings.
Moving averages with equivalent RC time
constants:
2 0.08 sec.
3 0.15 sec.
4 0.3 sec.
5 0.6 sec.
6 1.2 sec.
7 2.4 sec.
8 4.8 sec.
9 9.6 sec.
A Unfiltered

d.dddd
Determines decimal
point position & reading
resolution.

d.dddd dd.ddd ddd.dd dddd.d ddddd.
.ddddd Press ^ key to shift decimal point.
Decimal point is stored in TEDS memory.
Display shows TEds instead of StorE.

Option board dependent menu items
ALSEt. ALS34 dEU1H dEU2H dEU1b dEU2b dEU3H DEU4H DEU3b DEU4b
Menu items related to alarm setup These will only appear if a relay board is detected. If
so, please see Section14.
AnSEt. An Lo. An Hi..
Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 15.
tArE_
Tare & TEDS
selections.

00000 Calibration due
indicator.

0 Calibration due indicators enabled
1 Calibration due indicators disabled

00000 Front panel
pushbutton Tare.

0 Front panel tare enabled
1 Front panel tare disabled

00000
Auto-Tare.

0 Tare after meter reset
1 No tare after meter reset

00000 TEDS Plug and
Play indicator.

0 TEDS Plug and Play indicator enabled
1 TEDS Plug and Play Indicator disabled

00000
TEDS Plug and Play.

0 TEDS Plug and Play enabled
1 TEDS Plug and Play disabled
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MENU
KEY

DIGIT
SELECT KEY

VALUE
SELECT KEY

Option board dependent menu items
SEr 1. SEr 2. SEr 3. SEr 4. _Addr
Menu items related to serial communications. These will only appear if an RS232,
RS485, or USB I/O board is detected. If so, see Section 16.
dAtE
Current date

Use keypad to enter the current date in MM.DD.YY format. This menu item
appears as an error message when the battery has just been replaced, or
in other instances where the date in the instrument is obviously not correct.
The meter remains non-functional until the current date has been entered.

CAL rt
Cal Reset

The Cal Instrument indicator starts flashing 30 days before instrument
calibration is due. To acknowledge and turn off flashing, change the first
digit of this menu item from 1 to 0. The Cal Sensor
indicator starts
flashing 30 days before sensor calibration is due. To acknowledge and turn
off flashing, change the second digit of this menu item from 1 to 0.

CALd II
Instr cal date

00.00.00 Meter calibration date in MM.DD.YY format. Read-only.

CALdS
Sens cal date

00.00.00 Sensor calibration date in MM.DD.YY format. Read-only.

SEr no
Transducer
Serial No.

If the serial number is 6 digits or less, press the Peak key once to display
all digits 123456. If the serial number is greater than 6 digits, press Peak
once to display the first digits 12–___, and press the Peak key again to
display the remaining digits 345678. Read only.

UnitS_
Units of measure. Read
only.

CALInL
Cal initials

_A_ b_C Initials of the person who performed the transducer calibration.
Read only. Characters used are:

CALPEr
Cal period

___365 Required transducer calibration interval in days. Read only.

-M – IdBridge ID

brdg-A or brdg-b or brdg-C Identifies whether meter is monitoring
bridge A, bridge B, or bridge C.
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10. SETUP OF NON-TEDS TRANSDUCERS
10.1 SCALING METHODS
Three methods are selectable for scaling the meter, as follows:
Scale and Offset Method (using calculated scale and offset). This method requires that you
calculate the required scale and offset values and enter them into memory when the meter
displays SCALE and OFFst. No calibration signals need to be applied to the meter.
Coordinates of 2 Points Method (using values from sensor's calibration certificate). With this
method, you enter the low input signal value, the display value for the low signal, the high input
signal value, and the display value for the high input signal value. These values are entered
when menu items Lo In, Lo rd, HI In and HI rd are displayed. No calibration signals need to
be applied to the meter with this method, which is the most commonly used.
Reading Coordinates of 2 Points Method (applying a known weight or load). When using
this method, the meter calculates the proper scaling and offset values, entering them into
memory. The meter is connected to your sensor and looks at the values of the input signals to
calibrate the meter and transducer as a system.
10.2 Implementing Scale and Offset Method (using calculated scale factor and offset)
Apply power and press the MENU key until SEtuP appears on the display.
Press the PEAK key, and four digits will appear on the display. Continue pressing the PEAK
key until Digit 4 begins to flash _00_00. Make this digit a 0 by pressing the RESET key until 0
appears. Store the change by pressing the left MENU key. Perform any other programming
changes are required for your application.
10.3

Implementing Coordinates of 2 Points Input Method (using values from the sensor's
calibration certificate)

Apply power and press the MENU key until SEtuP appears on the display.
Press the PEAK key, and four digits will appear on the display. Continue pressing the PEAK
key until Digit 4 begins to flash _00_10. Make this digit a 1 by pressing the RESET key until 1
appears. Store the change by pressing the MENU key. Reset the meter.
Press the MENU key until Lo In appears. Using the PEAK and RESET keys, enter the low
input value. Push the MENU key until Lo rd appears. Using the PEAK and RESET keys, enter
the low reading to be displayed. Repeat this procedure for HI In and HI rd. Perform any other
programming changes that are required for your application.
10.4 Implementing Reading Coordinates of 2 Points Method (applying a known load)
Apply power and press the left MENU key until SEtuP appears on the display.
Press the PEAK key, and four digits will appear on the display. Continue pressing the PEAK
key until the Digit 4 begins to flash _00_20. Make this digit a 2 by pressing the RESET key
until 2 appears. Store the change by pressing the left MENU key. Reset the meter.
Go to Section 11 and perform the procedure of applying known low and high loads. Perform
any other programming changes that are required for your application.
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11. METER SCALING BY APPLYING KNOWN LOADS
Apply power and press the left MENU key until SEtuP appears on the display. Press the
PEAK key, and 4 digits will appear on the display. Continue pressing the PEAK key until
the Digit 4 begins to flash _00_20. Make this digit a 2 by pressing the RESET key until 2
appears. Store the change by pressing the left MENU key. Reset the meter. Connect the
meter to your sensor or transducer. Use the procedure below to scale your meter by
applying known loads.

MENU KEY

DIGIT SELECT
KEY

VALUE
SELECT KEY

_Lo In_ Press the
key.
Lo In will appear on the
meter display. Apply the low
known load.

_0.021 Press the
key.
The meter will begin to take
readings and display the low
signal value.

_0.021 Press the
key to
store the Lo In (low signal)
value.

_Hi In_ Press the
key.
Hi In will appear on the
meter display. Apply the high
known load.

20.094 Press the
key.
The meter will begin to take
readings and display the high
signal value.

20.094 Press the
key to
store the Hi In (high signal)
value.

_Lo rd_ Press the
key.
Lo Rd will appear on the meter display. Enter the desired
low load reading value.

_0001.5 Press the
key
to select a digit, which will
flash.
0.0000 0.0000 0.0000
0.0000 0.0000

0000.0 Press the
key to
select a value from 0 to 9 for
the flashing digit. The decimal is fixed by dEC.Pt.

_Hi rd_ Press the
key.
Hi Rd will appear on the meter display. Enter the desired
high load reading value.

_1000.0 Press the
key
to select a digit, which will
flash.
0.0000 0.0000 0.0000
0.0000 0.0000

5000.0 Press the
key to
select a value from 0 to 9 for
the flashing digit. The decimal is fixed by dEC.Pt.

- 18 -

12. TEDS SIGNAL CONDITIONER WITH NON-TEDS TRANSDUCERS

MENU
KEY

DIGIT SELECT
KEY

InPut
Input signal
type

_Strn_
Load cells. Factory default scaling is 50 mV FS
_dC u
DC millivolts

SEtuP
Meter Setup

VALUE SELECT KEY

__20.0 __50.0 _100.0 _250.0 _500.0
20, 50, 100, 250, 500 mV full scale.

00_00
Display type

0
1
2
3

4-1/2 digit meter, counts by 1
5-digit remote display (±99,999)
4-1/2 digit meter, counts by 10
3-1/2 digit meter

00 _00
Power line frequency

0 Noise minimized for 60 Hz
1 Noise minimized for 50 Hz

_0_00
Meter scaling method

0 Scale and offset method
1 Coordinates of 2 points method
2 Reading coordinates of 2 points method

00_00
Rear connector control
inputs 1 & 2
True = logic 1 (0V or
tied to digital ground)
False = 0 (5V or open)

0
1
2
3
4
5
6

1 = Reset, 2 = Meter Hold
1 = Function Reset 2 = Pk or Valley Disp.
1 = Meter Hold
2 = Pk or Valley Disp.
1 = Meter Hold
2 = Tare
1 = Peak or Valley 2 = Tare
1 = Tare
2 = Reset
1 = 0, 2 = 0, decimal point 1= XXXXX
1 = 1, 2 = 0, decimal point 1 = XXXX.X
1 = 0, 2 = 1, decimal point 1 = XXX.XX
1 = 1, 2 = 1, decimal point 1 = XX.XXX
7 1 = 0, 2 = 0, decimal point 2 = XXXX.X
1 = 1, 2 = 0, decimal point 2 = XXX.XX
1 = 0, 2 = 1, decimal point 2 = XX.XXX
1 = 1, 2 = 1, decimal point 2 = X.XXX.X
8 1 = Function Reset 2 = Display Blank
9 1 = Hold
2 = Display Blank
A 1 = Peak or Valley 2 = Display Blank
B 1 = Tare
2 = Display Blank
C 1 = Valley Display 2 = Peak Display
D 1 = Tare
2 = Tare Reset
Both control inputs 1 & 2 set to 1 for selections
2, 4, A, C = Function Reset.
Both control inputs 1 & 2 set to 1 for selections
0, 1, 3, 5, 8, 9, B, D = Meter Reset.
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MENU
KEY

DIGIT SELECT
KEY

ConFG
Meter
Configuration

000_0
Operation as a rate of
change meter.
Extended meter only.

0
1
2
3
4
5
6

000_0
Operation of front panel
PEAK button and rear
connector for Peak or
Valley Display

0 Peak Display. Also selects “Peak” in
“Peak or Valley” at connector above.
1 Valley Display. Also selects “Valley” in
“Peak or Valley” at connector above.
2 Peak (1st push), Valley (2nd push)

000_0_
Signal polarity.

0 Normal signal polarity
1 Reverse signal polarity

000_0_
Nonlinear input scaling
Extended meter only..

0 Linear input
1 Custom curve linearization

00000
Alarm filtering

0 Alarm unfiltered
1 Alarm filtered

00000
Peak & Valley filtering

0 Peak & Valley unfiltered
1 Peak & Valley filtered

00000
Display filtering

0 Display batch average every 16 readings
1 Display filtered signal

00000
Adaptive filter threshold

0 Low adaptive filter threshold level
1 High adaptive filter threshold level

00000
Input signal filtering.
Can be applied to display, setpoint, analog
output, data output.

0
1
2
3
4
5
6
7
8
9
A

d.dddd
Decimal point flashes.

d.dddd dd.ddd ddd.dd dddd.d ddddd.
.ddddd

FiLtr
Filtering

dEc.Pt
Dec. point
selection

VALUE SELECT KEY

Not rate of change
Rate x 0.1
Rate x 1
Rate x 10
Rate x 100
Rate x 1000
Rate x 10000

Autofilter
Batch average, 16 readings
Moving average, 0.08 sec.
Moving average, 0.15 sec.
Moving average, 0.3 sec.
Moving average, 0.6 sec.
Moving average, 1.2 sec.
Moving average, 2.4 sec.
Moving average, 4.8 sec.
Moving average, 9.6 sec.
Unfiltered
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MENU
KEY

DIGIT SELECT
KEY

VALUE SELECT KEY

Scaling method “Scale and Offset” if selected under SEtuP
SCALE
Scale factor

0.0000 0.0000 0.0000
0.0000 0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Select decimal point
location when decimal point is flashing.

OFFst
Offset value

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point location
is selected by dEC.Pt.

Scaling method “Coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal
input.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set by
input range chosen.

Lo rd
Desired reading at Lo In.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set by
dEC.Pt.

Hi In.
High signal
input.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set by
input range chosen.

Hi rd.
Desired reading at Hi In.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set by
dEC.Pt.

Scaling method “Reading coordinates of 2 points” if selected under SEtuP
Lo In.
Low signal
input.

_0.021
Apply a low reference
signal to the meter.

_0.021
Press to store the low signal input in the
meter.

Hi In.
High signal
input.

_20.094
Apply a high reference
signal to the meter.

_20.094
Press to store the high signal input in the
meter.

Lo rd
Desired reading at Lo In.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

0.0000
Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set by
dEC.Pt.

Hi rd.
Desired reading at Hi In.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

6.7500
Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Decimal point is set by
dEC.Pt.
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Option board dependent menu items
ALSEt. ALS34 dEU1H dEU2H dEU1b dEU2b dEU3H DEU4H DEU3b DEU4b
Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section14.
AnSEt. An Lo. An Hi..
Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 15.
MENU
KEY

tArE_
Tare selections.

DIGIT SELECT
KEY

VALUE SELECT KEY

00000 Calibration
due indicator.

0 Calibration due indicators enabled
1 Calibration due indicators disabled

00000 Front panel
pushbutton Tare.

0 Front panel tare enabled
1 Front panel tare disabled

00000
Auto-Tare.

0 Tare after meter reset
1 No tare after meter reset

Option board dependent menu items
SEr 1. SEr 2. SEr 3. SEr 4. _Addr
Menu items related to serial communications. These will only appear if an RS232,
RS485, or USB I/O board is detected. If so, see Section 16.
dAtE
Current date

Use the keypad to enter the current date in MM.DD.YY format. This
menu item appears as an error message when the battery has just been
replaced, or in other instances where the date in the instrument cannot
be correct. The meter remains non-functional until the current date has
been entered.

CAL rt
Cal Reset

The Cal Instrument
indicator starts flashing 30 days before instrument
calibration is due. To acknowledge and turn off flashing, change the first
digit of this menu item from 1 to 0. The Cal Sensor
indicator starts
flashing 30 days before sensor calibration is due. To acknowledge and
turn off flashing, change the second digit of this menu item from 1 to 0.

CALd II

Calibration date of instrument in MM.DD.YY format.

Menu lockout items
Loc 1. Loc 2. Loc 3.
Menu items used to enable or lock out (hide) other menu items. Loc menu items may in
turn be locked out by a hardware jumper. Please see Section 8.
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13. LOAD CELL & MICROVOLT SIGNAL CONDITIONER
This section provides setup instructions to set up the DPM-3 signal conditioner for use with
load cells or strain gauges, or as a microvolt meter. The meter’s built-in, isolated 10 Volt,
120 mA excitation supply will power up to four 350 ohm load cells in parallel.
13.1 RANGE SELECTION VIA JUMPERS
Input
Range

Jumpers

Full Scale
Display

± 20 mV
± 50 mV
± 100 mV
± 250 mV
± 500 mV

e
a
b
c
d

± 20000
± 50000
± 10000
± 25000
± 50000

Notes 1. See Section 17 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1”).
3. If a TEDS sensor is connected, jumper for ± 50 mV.
13.2 MENU SELECTION
Display in engineering units can be programmed by either the Scale and Offset Method,
Coordinates of 2 Points Method, or Reading Coordinates of 2 Points Methods.
With the Scale and Offset Method, scale and offset are calculated as follows, and are
then entered manually. The example below is for 0 to 20 mV = 0 to 100.00.
Input span = Hi signal in – Lo signal in
Input ratio =Input range / Input span

Input span = 20 mV – 0 mV = 20 mV
Input ratio = 20 mV / 20 mV = 1.00

Display span = Hi display – Lo display
Display ratio = FS Display / Display span

Display span = 10000 – 0000 = 10000
Display ratio = 20000 / 10000 = 2.00

Scale Factor = Input ratio / Display ratio

Scale Factor = 1.00 / 2.00 = 0.5000

Offset = – (Lo signal in / Input span) x
Display span + Lo display

Offset = – (0 mV / 20 mV x 10000) + 0000
= 0000

With the Coordinates of 2 Points Method, values for low signal input, low display
reading, high signal input and high display reading must be entered manually. For
example, if the desired scaling is 0 to 30 mV = 0 to 500.0, the 50 mV full scale range
would be selected and values would be entered as follows:
Lo in = 00.000
Hi in = 30.000

Lo rd = 0000.0
Hi rd = 0500.0

In the Coordinates of 2 Points example below, 0 to 20 mV = 00000 to 50000. During
setup, it may be necessary to enable some menu items. See Section 8 for information.
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MENU KEY

DIGIT SELECT
KEY

VALUE SELECT KEY

_0020.0

Press
to display InPut
(input type).

_Strn
Press
key until Strn
(ratiometric) is displayed.

_SEtuP

_30_00

Press
to display SEtuP
(basic setup). See Section
18 for description of digits
1 - 5.

Press
to select digit,
which will flash.

_00_10
12345

_ConFG

_00000
12345

_InPut

Press
to display ConFG
(configuration). See Section Press
to select digit,
18 for description of digits 1 - which will flash.
5.

Press
to select 20.0,
50.0, 100.0, 250.0 or 500.0
mV.

Press

key to select value.

_00000
12345
Press

to select value.

_dEc.Pt

_d.dddd

_ddddd.

Press
to display dEcPt
(decimal point).

Press
to display decimal
point location.

Press
to change decimal
point location.

_Lo in

_00.000

_00.000

Press
to display Lo in
(low signal input value).

Press
to select digit,
which will flash. Decimal
point is fixed by input range.

Press
to set digit values.
Set to 00.000 mV. Leftmost
digit may be set to 0 thru 9
and -0 thru -9.

_Lo rd

_00000

_00000

Press
to display Lo rd
(desired meter reading at
low signal input).

Press
to select digit,
which will flash. Decimal
point is fixed by dEc.Pt

Press
to set digit values.
Set to 0.

_Hi in

_00.000

_20.000

Press
to display Hi in
(high signal input value).

Press
to select digit,
which will flash. Decimal
point is fixed by input range.

Press
to set digit values.
Set to 20.000 mV.

_Hi rd

_00000

_50000

Press
to display Hi rd
(desired meter reading at
high signal input).

Press
to select digit,
which will flash. Decimal
point is fixed by dEc.Pt.

Press
to set digit values.
Set to 0.

_rESEt
Press
(or
and
simultaneously) until rESEt is displayed. The meter will go to the
operating mode and display the value of the input signal.
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14. DUAL OR QUAD RELAY OUTPUT OPTION
An optional relay board may be installed in the
meter main board at plug position P2, adjacent
to the power supply board. Four board ver- Alarm status
indicators
sions are available: 2 or 4 relays, mechanical
1 through 4
or solid state. Once installed, the relay board is
recognized by the meter software or PC-based
Instrument Setup software, which will bring up the appropriate menu items for it. These menu
items will not be brought up if a relay board is not detected. All relay boards offer a choice of
operating modes: normally off or on, latched or non-latched, hysteresis band, deviation band,
alarm based on the filtered or unfiltered signal, and selectable number of readings in alarm
zone to cause an alarm.
KEYSTROKES FOR VIEWING & CHANGING SETPOINTS
The
(Alarms) key can be used to step through and view setpoints while the meter continues
to make conversions and performs setpoint control. If the
(Peak) key is pressed while a
setpoint is displayed, conversion stops and the setpoint can be changed. After pressing
,
you have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item
Loc3, digit 2, must have been set to 0. To change setpoints, menu item Loc2, digit 2, must
have been set to 0.
DIGIT SELECT KEY

ALARMS KEY

VALUE SELECT
KEY

300.24
Press , (Alarms)
to display Alarm 1
setpoint.

_200.00
Current setpoint 1 value blinks, and
Alarm 1 LED indicator lights. Press
to select a digit, which will blink.

_295.00
To change setpoint 1 value,
press
to change
selected blinking digits.

395.00
Press , (Alarms)
to display Alarm 2
setpoint.

_395.00
Current setpoint 2 value blinks, and
Alarm 2 LED indicator lights. Press
to select a digit, which will blink.

_305.00
To change setpoint 2 value,
press
to change
selected blinking digits.

395.00
Press , (Alarms)
to display Alarm 3
setpoint.

_395.00
Current setpoint 3 value blinks, and
Alarm 3 LED indicator lights. Press
to select a digit, which will blink.

_305.00
To change setpoint 3 value,
press
to change
selected blinking digits.

395.00
Press , (Alarms)
to display Alarm 4
setpoint.

_395.00
Current setpoint 4 value blinks, and
Alarm 4 LED indicator lights. Press
to select a digit, which will blink.

_305.00
To change setpoint 4 value,
press
to change
selected blinking digits.

300.24 Press

, (Alarms) again. Meter will reset and display current reading.
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KEYSTROKES FOR SETPOINT SETUP
If the MENU
key does not work, see Section 8 “Enabling & Locking Out Menu Items.”
MENU KEY

DIGIT SELECT
KEY

VALUE SELECT KEY

ALSEt
Alarm Setup for
relays 1 & 2 if
detected.

00000
Relay state when
alarm is active.

0
1
2
3

Relay 1 on
Relay 1 off
Relay 1 on
Relay 1 off

Relay 2 on
Relay 2 on
Relay 2 off
Relay 2 off

Press until
ALSEt is displayed.

00000
Alarm latching or nonlatching (auto reset).

0
1
2
3

Alarm 1 auto reset
Alarm 1 latching
Alarm 1 auto reset
Alarm 1 latching

Alarm 2 auto reset
Alarm 2 auto reset
Alarm 2 latching
Alarm 2 latching

00000
Alarm operates at and
above setpoint (active
high) or at and below
setpoint (active low).

0
1
2
3
4
5
6
7
8

AL1 active high
AL1 active low
AL1 disabled
AL1 active high
AL1 active low
AL1 disabled
AL1 active high
AL1 active low
AL1 disabled

AL2 active high
AL2 active high
AL2 active high
AL2 active low
AL2 active low
AL2 active low
AL2 disabled
AL2 disabled
AL2 disabled

00000
Hysteresis mode or
band deviation mode

0
1
2
3
4
5
6
7

AL1 band deviation AL2 band deviation
AL1 split hysteresis AL2 band deviation
AL1 band deviation AL2 split hysteresis
AL1 split hysteresis AL2 split hysteresis
No deviation or hysteresis in menu.
AL1 span hysteresis AL2 band deviation
AL1 span hysteresis AL2 split hysteresis
AL1 span hysteresis AL2 span hysteresis

00000
Number of consecutive
readings in alarm zone
to cause an alarm.

0
1
2
3

After 1 reading
After 2 readings
After 4 readings
After 8 readings

4
5
6
7

00000
Relay state when
alarm is active.

0
1
2
3

Relay 3 on
Relay 3 off
Relay 3 on
Relay 3 off

Relay 4 on
Relay 4 on
Relay 4 off
Relay 4 off

00000
Alarm latching or nonlatching (auto reset).

0
1
2
3

Alarm 3 auto reset
Alarm 3 latching
Alarm 3 auto reset
Alarm 3 latching

Alarm 4 auto reset
Alarm 4 auto reset
Alarm 4 latching
Alarm 4 latching

ALS34
Alarm Setup for
relays 3 & 4 if
detected.
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After 16 readings
After 32 readings
After 64 readings
After 128 reading

MENU KEY

ALS34
Alarm Setup for
relays 3 & 4
(continued)

dEU1H Alarm 1
hysteresis
DEU2H Alarm 2
hysteresis
DEU1b Alarm 1
band deviation
DEU2b Alarm 2
band deviation
dEU3H Alarm 3
hysteresis
DEU4H Alarm 4
hysteresis
DEU3b Alarm 3
band deviation
DEU4b Alarm 4
band deviation

VALUE SELECT
KEY

DIGIT SELECT KEY

00000
Alarm operates at and
above setpoint (active
high) or at and below
setpoint (active low).

0
1
2
3
4
5
6
7
8

AL3 active high
AL3 active low
AL3 disabled
AL3 active high
AL3 active low
AL3 disabled
AL3 active high
AL3 active low
AL3 disabled

AL4 active high
AL4 active high
AL4 active high
AL4 active low
AL4 active low
AL4 active low
AL4 disabled
AL4 disabled
AL4 disabled

00000
Hysteresis mode or
band deviation mode
(see Glossary)

0
1
2
3

AL3 band deviation
AL3 hysteresis
AL3 band deviation
AL3 hysteresis

AL4 band deviation
AL4 band deviation
AL4 hysteresis
AL4 hysteresis

00000
Number of consecutive
readings in alarm zone
to cause an alarm.

0
1
2
3

After 1 reading
After 2 readings
After 4 readings
After 8 readings

4
5
6
7

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Alarms will activate
above the setpoint by the value entered and
deactivate below the setpoint by the value
entered.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Alarms will activate
above and below the setpoint by the value
entered and will deactivate in the middle of
the band.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Alarms will activate
above the setpoint by the value entered and
deactivate below the setpoint by the value
entered.

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first digit, 0 thru 9
for other flashing digits. Alarms will activate
above and below the setpoint by the value
entered and will deactivate in the middle of
the band.
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After 16 readings
After 32 readings
After 64 readings
After 128 reading

15. ANALOG OUTPUT OPTION
An optional analog board may be installed in the meter at rear panel jack position J4, adjacent
to the signal conditioner board. Once installed, this board is recognized by the meter, which
will bring up the appropriate menu items for it. These will not be brought up if an analog output
board is not installed.
The analog output can be a 0-20 mA, 4-20 mA or 0-10V unipolar signal with respect to isolated
ground, or a bipolar -10V to +10V voltage signal with respect to a reference return line.
Unipolar or bipolar operation is selected by a jumper. A unipolar current or voltage output is
selected at the connector. Unipolar 4-20 mA or 0-20 mA current is selected in software.

Unipolar current of voltage: Jumper a
Bipolar -10 to +10 voltage: Jumper b
The low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low
displayed reading An Lo. The high analog output (20 mA, 0V or 10V) may be set to correspond to any high displayed reading An Hi. The meter will then apply a straight line fit between
these two end points to provide an analog output scaled to the meter reading.
KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 8 “Enabling & Locking Out Menu Items.”
MENU KEY

VALUE SELECT
KEY

DIGIT SELECT KEY

AnSEt
Analog Output Setup.
Press until AnSEt is
displayed (requires
analog output board).

___00
Analog output signal
selection.

0
1
2
3

___00
Analog output filtering.

0 Analog output unfiltered
1 Analog output filtered

An Lo
Low displayed value
for 0 mA, 4 mA, 0V, or
-10V output

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first
digit, 0 thru 9 for other flashing
digits. Decimal point location is
fixed by dEC.Pt selection.

An Hi.
High displayed value
for 20 mA or 10V output

0.0000 0.0000 0.0000
0.0000 0.0000
Select digit to flash.

Select -9 thru 9 for flashing first
digit, 0 thru 9 for other flashing
digits. Decimal point location is
fixed by dEC.Pt selection.
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0-20 mA current output
0-10V voltage output
4-20 mA current output
-10 to +10V voltage output

16. SERIAL COMMUNICATION OPTIONS
A serial communications board may be connected to the DPM-3 meter main board at plug
position P13 (middle position). Available boards are RS232, RS485 (with dual RJ11 connectors), RS485 Modbus (with dual RJ45 connectors), USB, and a USB-to-RS485 converter. The
dual connectors of RS485 boards are wired in parallel to allow daisy chaining of addressable
meters without the use of a hub. Three serial communication protocols are selectable for all
serial boards: Custom ASCII, Modbus RTU, and Modbus ASCII.
A USB-to-RS485 converter board allows a DPM-3 meter to be interfaced to a computer and
to be the device server for a network of up to 31 other meters on an RS485 bus, while itself
retaining all capabilities of a meter. The remote meters need to be equipped with our RS485
digital interface board DPM-3-OPT-TRS485. This board has dual 6-pin RJ11 jacks, which are
wired in parallel to allow multiple meters to be daisy-chained using readily-available 6-wire
data cables with no need for hand-wiring or an RS485 hub. The outer two wires are used for
ground.
Use 6-wire, straight-through data cables, not 4-wire telephone cables or crossover cables,
all the way from the device server to the last device on the RS485 bus. Connect ATX to ATX,
BTX to BTX, etc., with no crossover as you go from device to device.
To connect a meter with a USB board to a computer, use a USB cable with Type A and
Type B connectors. The computer will display “Found new Hardware” followed by “Welcome to
the Found new Hardware Wizard.” Follow the instructions for software installation from a CD.
When the installation is complete, use Device Manager to determine the COM port. To get to
Device Manger, go to the Windows Control Panel, click on System, click on the Hardware tab,
then click on Device Manager. Go down the device list and click on Ports (COM & LPT) and
USB serial port (COM #). Note the COM port # for use with communications to your meter,
then exit Control Panel. If you later need to change the COM port, right-click on USB serial port
(COM #), then on Properties, Port settings, and Advanced. Change port to the desired number,
click OK, then exit Control Panel.
DOWNLOADABLE SOFTWARE AND MANUALS
Windows-based software is available from Transducer Techniques to program our meters
and transmitters via a PC using the serial interface. This software can be downloaded at no
charge from www.transducertechniques.com/online-manuals.aspx. Please see Section 19 for
details.
Software manuals for the Custom ASCII and Modbus Protocols can also be downloaded from
www.transducertechniques.com/online-manuals.aspx.
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BOARD SETUP VIA JUMPERS

USB Board
No jumpers required.

RS232 Board
e - RTS enabled by external source (otherwise always
enabled).
f - Slave display to RS232 from another meter.
g - Required for RS232 operation.
Note: Board is shipped with jumper g installed.
RS485 Board, Full Duplex Operation
b & d - Installed on last meter in long cable run.
RS485 Board, Half Duplex Operation
a & c - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.
Note: Board is shipped with no jumpers installed.
RS485-Modbus Board, Full Duplex Operation
b & e - Bias jumpers should be installed on 1 board.
a & d - Installed on last meter in long cable run.
RS485-Modbus Board, Half Duplex Operation
b & e - bias jumpers installed on 1 board.
c & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs.
Note: Board is shipped with no jumpers installed.
USB-to-RS485 Converter Board
Full Duplex Operation
No jumpers for short cable runs.
Add b & d for long cable runs.
Half Duplex Operation
a & c - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.
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d c
a

b

e

f

RJ45
RJ45

Modbus

KEYSTROKES FOR SETUP
If the MENU
key does not work, see Section 8 “Enabling & Locking Out Menu Items.”
MENU KEY

.SEr 1.
Fixed Parameters:
No parity
8 data bits
1 stop bit

DIGIT SELECT
KEY

VALUE SELECT KEY

__000
Output filtering

0 Send unfiltered signal
1 Send filtered signal

__000U
Baud rate

0
1
2
3
4
5
6

300 baud
600 baud
1200 baud
2400 baud
4800 baud
9600 baud
19200 baud

0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

60 Hz
Line frequency
0.28 sec
0.57 sec
1.1 sec
2.3 sec
4.5 sec
9.1 sec
18.1 sec
36.3 sec
72.5 sec
145 sec
290 sec
580 sec
1161 sec
2321 sec
4642 sec

__000U
Output update rate

.SEr 2.
Serial Setup 2

50 Hz
Line frequency
0.34 sec
0.68 sec
1.4 sec
2.7 sec
5.4 sec
10.9 sec
21.8 sec
43.5 sec
87 sec
174 sec
348 sec
696 sec
1393 sec
2785 sec
5571 sec

_0000U
Line feed

0 No line feed after carriage return
1 Line feed after carriage return

_0000U
Alarm data with readings

0 No alarm data
1 Alarm data with reading

_0000U
Control of data output

0 Continuous data output
1 Data output on ASCII command only

_0000U
Meter address with Custom
ASCII protocol

Select 1 thru F for addresses 1 thru 15.
Select 0. thru F. (with decimal point) for
addresses 16 thru 31.

- 31 -

MENU KEY

.SEr 3.
Serial Setup 3

SEr 4.
Serial Setup 4.

_Addr
Modbus Address.
Appears only if the
Modbus protocol is
selected.

DIGIT SELECT
KEY

VALUE SELECT KEY

00000U
Half or full duplex

0 Full duplex
1 Half duplex

00000U
Special start & stop char.

0 Standard continuous mode
1 Special start & stop characters

00000U
RTS mode

0 Normal RTS
1 Single transmission

00000U
Termination characters

0 Only at end of all items
1 At end of each item

00000U
Data sent in continuous
mode

0
1
2
3
4
5

Reading
Peak
Valley
Reading + peak
Reading + valley
Reading + peak + valley

__000U
Modbus ASCII gap timeout

0
1
2
3

1 sec
3 sec
5 sec
10 sec

__000U
Serial protocol

0 Custom ASCII
1 Modbus RTU
2 Modbus ASCII

__000U
Parity

0 None, 2 or more stop bits
1 Odd, 1 or more stop bits
2 Even, 1 or more stop bits

__000 __000 __000
Select digit to flash.

__247
Select 0 through 9 for flashing digit.
Address range is 1 to 247.
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SERIAL CONNECTION EXAMPLES
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17. EXCITATION OUTPUTS & POWER SUPPLY
Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated.
In addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (85-264 Vac) and to the low voltage power
supply (12-32 Vac or 10-48 Vdc).

Excitation output

Jumper locations

5 Vdc ±5%, 100 mA max

b, d, e

10 Vdc ±5%, 120 mA max

b, d, f

24 Vdc ±5%, 50 mA max

c

SELECTION OF OTHER JUMPERS
Jumper a
Jumper g
Jumper h

-

Front panel menu lockout, locked when installed. (See Section 8)
Provides +5V power output at P1-4 when installed.
Connects "Control Input 2" to P1-4 when installed.
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18. DIGITAL CONTROL INPUTS
18.1 FUNCTION OF DIGITAL INPUTS
Logical 0 Current display value is set to zero and is stored as offset value.

Valley Display

Logical 1 Displayed value equals signal input less tare value.
Logical 0 Peak or Valley value of input signal is displayed.
Logical 1 Current value of input signal is displayed.
Logical 0 Meter display and outputs are held at last reading prior to hold
going low.
Logical 1 Display and outputs are updated normally.
Logical 0 Microcomputer reads and resets meter to values stored in nonvolatile memory.
Logical 1 Meter display and outputs operate normally.
Logical 0 Microcomputer resets peak to current value, and resets alarms.
Logical 1 Meter display and outputs operate normally.

18.2 MENU SELECTIONS
MENU
KEY

DIGIT
SELECT KEY

_SEtuP
Press the
until SEtuP
(meter setup)
is displayed.

_0___0
12345
Press
to select digit
5, which will flash.

Both inputs A and B set to 1 for selections
2, 4, A, C = Function Reset
Both inputs A and B set to 1 for selections
0, 1, 3, 5, 8, 9, B, D = Meter Reset
External decimal DP1 & DP2 control the
decimal point positions and override the
decimal point selection in SEtuP.

VALUE SELECT KEY

_0___0
12345
Press
to set value for flashing digit.
0 A = Reset
B = Meter Hold
1 A = Function Reset B = Peak or Valley Disp.
2 A = Meter Hold
B = Peak or Valley Disp.
3 A = Meter Hold
B = Tare
4 A = Peak Display B = Tare
5 A = Tare
B = Reset
6 A = 1, B = 1, decimal point 1= XXXXX
A = 0, B = 1, decimal point 1 = XXXX.X
A = 1, B = 0, decimal point 1 = XXX.XX
A = 0, B = 0, decimal point 1 = XX.XXX
7 A = 1, B = 1, decimal point 2 = XXXX.X
A = 0, B = 1, decimal point 2 = XXX.XX
A = 1, B = 0, decimal point 2 = XX.XXX
A = 0, B = 0, decimal point 2 = X.XXX.X
8 A = Function Reset B = Display Blank
9 A = Hold
B = Display Blank
A A = Peak or Valley B = Display Blank
B A = Tare
B = Display Blank
C A = Valley Display B = Peak Display
D A = Tare
B = Tare Reset
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19. INSTRUMENT SETUP & DATA DISPLAY VIA PC
DPM-3 Instrument Setup software is a PC program which is much easier to learn than front
panel programming. It is of benefit whether or not the meter is connected to a PC. With the
meter connected to a PC, it allows uploading, editing and downloading of setup data,
execution of commands under computer control, and the listing, plotting and graphing of
data. With the meter unconnected to a PC, it provides quick selection of jumper locations
and a printable display of menu selections for front panel setup.
SOFTWARE INSTALLATION
As a first step, temporarily set User Account Control (UAC) of Windows to “Never notify” so
that installation of DPM-3/SST Instrument Setup can create directories. Use Google for
instructions on how to change UAC settings for your version of Windows. Following installation, return UAC to its previous setting.
Download DPM-3 Instrument Setup software from www.transducertechniques.com/onlinemanuals.aspx onto your PC. Double-click on the downloaded file to unzip it into a special
directory, such as c:\Program Files\DPM-3\IS. Within that directory, double-click on
setup.exe, which will install the software on your PC. Prerequisites for connected use are
the following:
DPM-3 meter with a DPM-3-OPT-T (RS232 option) or DPM-3-OPT-U (USB option).
PC-compatible computer with an available RS232 or USB port.
RJ11-to-DB9 RS232 cable (P/N DPM-3-RJ11AD9) or commercial USB cable to connect
the meter to the PC.
DPM-3 Instrument Setup software.
ESTABLISHING COMMUNICATIONS
Connect the meter to the PC. Apply power, and keep the meter in RUN Mode. To start the
software from Windows, click on Start > Programs > DPM-3 Digital Panel Meter > DPM-3
Instrument Setup. Select the proper COM port and baud rate. Click on RS232 > Establish.
The program will temporarily set the selected COM port to the required baud rate, parity,
data bits and stop bit. Once communications have been established, click on Main Menu.
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SETUP OF CONNECTED METER
A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.
You will find that DPM-3 Instrument Setup software is very user friendly, with separate tabselectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.
ADDITIONAL FEATURES
The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading 0’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

Plot

Graph
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The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.
- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print
for a hardcopy. List can capture peak
readings.
- Plot generates a plot of readings vs.
time in seconds. It effectively turns the
DPM-PC combination into a printing
digital oscilloscope.
- Graph generates a histogram, where
the horizontal axis is the reading and
the vertical axis is the number of
occurrences of readings. The display
continually resizes itself as the number of readings increases.
The Jumpers pull-down menu provides
jumper positions for the various meter boards, duplicating information in this manual.
METER SETUP WITH AN UNCONNECTED PC
DPM-3 Instrument Setup software is also of benefit
when the PC is not connected to a meter. Upon launching the software, click on None for Communications,
then on DPM-3 and Continue. Click on File => Default
Setup to retrieve a default setup file from disk, or on File
=> Open Setup to retrieve a previously saved setup file
from disk.
To enter new setup information, click on View => Setup,
then make your screen selections as if you were
connected to a meter. Tabs will be grayed out if you
have not selected the required hardware under the
Input+Display tab. When done, press on Main Menu,
then on View => Menu. The selections made under
Setup will now be shown in the form of the required front
panel programming sequence, where each row corresponds to a menu item selected by the
key, and the
seven data columns correspond to values entered via the

and

keys.

Click on any step in the sequence to bring up a detailed help window. Click on Print for a
hardcopy, which you can then use as an instruction sheet to program your meter via its front
panel. Click on Main Menu => File => Save Setup As to save your setup to disk and have
an electronic record.
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20. CUSTOM CURVE LINEARIZATION
Curve.exe is a DOS-based, executable PC program used to set up an Extended meter so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on pressure measured at the bottom of the tank. The
curve-fitting algorithm uses quadratic
segments of varying length and curvature, and provides diagnostics to estimate curve fitting errors. The program is
self-prompting, avoiding the need for a
detailed printed manual. This manual
section is only intended as an introduction.
PREREQUISITES
1) PC-compatible computer with an available USB or RS232 communications port.
2) Extended DPM-3 meter.
3) A USB or RS232 board in the meter. This board can be used for meter setup only, then
be removed.
4) USB cable, A to B, or RS232 cable, RJ11-to-DB9 (P/N DPM-3-RJ11AD9), to connect
the meter and PC.
5) Curve.exe software, available from Transducer Techniques.
GETTING STARTED
Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the
key to get to SEr 1, then
set the entry to __050. Set the meter address to 1. To do so, press the
key to get to SEr
2, then set the entry to _0011. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.
You will be given the choice to enter your data in one of four modes:
1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV
or V. Y is the desired corresponding reading, and can range from -99999 to 99999 with
any decimal point.
2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.
3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1X^P1 + K2X^P2 +
K3*X^P3 + … are entered. Up to 20 terms are allowed. An offset can be built into X.
You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPM4L started to ship in August 2000.
You will be asked to supply the following:
LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >
This informs the computer of your signal conditioner jumper settings. Enter 0 and 0 for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 50mV. For HIGH INPUT MEASUREMENT VALUE, enter 20000
Position of the decimal point from 6=X.XXXXX, 5= XX.XXX, 4=XXX.XXX, 3=XXXX.XX,
2=XXXXX.X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the dEc.Pt decimal point menu selection.
Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.
KEYPAD CONTROL
You can take a meter in and out of custom curve linearization using the meter keypad.
From the Menu mode, press the
key to get to ConFG, then set the fifth digit to either 0
(normal linear operation) or to 1 (custom curve operation). This fifth digit will only be
displayed with an Extended meter.
FILES USED OR CREATED BY CURVE.EXE
1) *.RAW is the raw input file generated by all four data entry methods.
2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.
3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.
4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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21. METER CALIBRATION
All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.
Annual meter recalibration by the factory is recommended. Please contact Transducer
Techniques for an RMA number.

22. SPECIFICATIONS
Display
Type .................................... 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
Color .................................................................................................................................. Red
Range .......................................................................................................... -99999 to +99999
TEDS Status Indicator .................................................................................. Yellow LED lamp
TEDS Status................................................. With a TEDS transducer, lamp lights with TEDS
enabled and in Plug and Play mode
A-TO-D Conversion
Read Rate ............................................................... 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update Rate .....................................................................56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate .....................................................................3.5/s at 60 Hz, 3/s at 50 Hz
Noise Rejection
CMV from DC to 60 Hz ................................................................................Withstand 250Vac
Dielectric strength....................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMR from DC to 60 Hz ................................................................................................ 130 dB
NMR at 50/60 Hz ............................................................... 90 dB with minimum digital filtering
Control Inputs (CMOS/TTL levels, logic 0 = tied to digital ground, logic 1 = open)
/ Hold input .......................................................................... Logic 0 holds display and outputs
/ Peak or Valley input ......................................................... Logic 0 displays peak/valley value
/ Tare input ......................................................................... Logic 0 offsets input value to zero
/ Tare Reset .........................................................................Logic 0 resets Tare value to zero
/ Reset input ........................................................................ Logic 0 resets all meter functions
/ Function Reset input ................................................. Logic 0 resets peak values and alarms
/ Decimal Point input ..................... Overrides internal DP selections and controls DP position
/ Display Blank input .....................................................................Logic 0 shuts off the display
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Accuracy
Input Range

Resolution

Output Zero
Range

Output Span
Range

Error at 25°C

20.000 mV
50.000 mV
100.00 mV
250.00 mV
500.00 mV

1 µV
2.5 µV
5 µV
12.5 µV
25 µV

-99,999
to
+99,999

0
to
±99,999

0.01% of
Full Scale
±2 counts

Span Tempco (load cell signal conditioner) ..........................................0.0015% of reading/°C
Zero Tempco ............................................................................................................ 0.2 µV/°C
Power Requirements
Input Voltage rating (standard) ....................................................... 85-264 Vac or 90-300 Vdc
Input Voltage rating (low voltage option) ............................................ 12-32 Vac or 10-48 Vdc
Power Line Frequency ................................................................................. DC and 47-63 Hz
Power Consumption, Max ........................................................................................... 5 Watts
Excitation Outputs
Voltage & Current Levels (jumper selectable) .................................. 5 Vdc ±5%, 100 mA max
....................................................................................................... 10 Vdc ±5%, 120 mA max
........................................................................................................ 24 Vdc ± 5%, 40 mA max
Excitation Output Ripple .....................................................................................100 mVp max
Isolation from power and outputs ............................................................................... 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation to signal common ........................................................................................... 50 Vdc
Dual & Quad Relay Options
Power to Relay Option ................................................................................Powered by meter
Setpoint Setup ....................................... Via front panel pushbuttons or serial communication
Update Rate .................................................................................56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (min) .................................................................. Display update rate
Input Signal (selectable) ........................................................ Filtered or unfiltered input signal
Actuation Modes (selectable) ...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (selectable) .................................................................... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable) ................ 1) Display and change setpoints
................................................................................... 2) Display but do not change setpoints
.................................................................................. 3) Neither display nor change setpoints
Alarm Status Indication .......................................................................... 2 or 4 red LED lamps
Status Indication Setup (selectable) ....................... Lit when output is ON or OFF, or disabled
Form C, SPDT Relay Output:
AC Rating ..........................................................................................................8A @ 240 Vac
DC Rating ........................................................................................................... 8A @ 24 Vdc
Isolation rating between signal common and contacts ............................................... 250 Vac
Insulation dielectric strength between signal common and contacts ........................................
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
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Form A, SPST Solid State Relay Output:
AC Rating ..................................................................................................120 mA @ 140 Vac
DC Rating ..................................................................................................120 mA @ 180 Vdc
Isolation rating between signal common and contacts ............................................... 250V ac
Insulation dielectric strength between signal common and contacts ........................................
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Analog Output Option
Power to Analog Output Option ...................................................................Powered by meter
Output Levels ..............................................................0-20 mA, 4-20 mA, 0-10V, -10 to +10V
Voltage Compliance, 0-20 mA Output .................................................. 12V (0-600 Ohm load)
Current Compliance, 0-10V, -10 to +10V Output.......................2 mA (5 kOhm or higher load)
Accuracy .......................................... Meter input accuracy ±0.02% of full scale analog output
Resolution ........................................................................................... 16 bit (1 part in 65,536)
Response Time ....................................................................................... 50/60Hz update rate
Scaling of Reading for Zero Output ............................................................-99,999 to +99,999
Scaling of Reading for Full Scale Output ................................................... -99,999 to +99,999
Isolation rating between signal common and analog output ....................................... 250V ac
Insulation dielectric strength between signal common and analog output ................................
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards)
Output Types ...................... RS232, RS485, RS485-Modbus, USB, USB-to-RS485 converter
Power to Interface Option ............................................................................Powered by meter
RS485 Wiring ............................................................................................... Half or full duplex
Baud Rates ............................................................ 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols ............................. Custom ASCII, Modbus RTU, Modbus ASCII (selectable)
Signal Levels ................................................................. Meet RS232, RS485, USB standards
Isolation rating between signal common and serial I/O .............................................. 250V ac
Insulation dielectric strength between signal common and serial I/O .......................................
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Option Board Connectors:
RS232 ..................................................................................................... Single RJ11 jack
RS485 ................................... Two RJ11 jacks (for daisy chaining with 6-wire data cables)
RS485 (for Modbus std) ........ Two RJ45 jacks (for daisy chaining with 8-wire data cables)
USB .......................................................................................................... USB type B plug
USB-to-RS485 converter ............................USB type B plug plus RJ11 jack to RS485 bus
Environmental
Operating Temperature ......................................................................................... 0°C to 55°C
Storage Temperature ........................................................................................ -40°C to 85°C
Relative Humidity ...................................................... 95% from 0°C to 40°C, non-condensing
Case ............................ NEMA-4X (IP65) from front when panel mounted (not verified for UL)
Shock ........................................................................... 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ............................................. 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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23. GLOSSARY OF TERMS
Adaptive Filter Threshold
A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows the meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.
Alarm, Latched
An alarm which stays actuated until reset.
Latched alarms can shut down machinery or
a process when an operating limit has been
exceeded, or maintain an alarm condition
until acknowledged by an operator.
Alarm, Non-latched
An alarm which changes state automatically
when the reading rises above a specified limit
and changes back automatically when the
reading falls below a limit.
Autofilter

A selectable digital filter mode which automatically selects an appropriate moving average filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Auto-tare

A selectable meter operating mode, where
the first reading following power-on or meter
reset is used to zero the display. Further
readings are then relative to this new zero.

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Counts

The reading displayed on the meter ignoring the decimal point.

Custom ASCII Protocol
A simplified serial communications protocol which allows 31 digital addresses.
Not an industry-standard protocol like the more complex Modbus protocol,
which is also offered with the meter.
Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and deactuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
- 44 -

Setting up a passband around a setpoint is
often used for component testing. Deviation
limits are programmed by entering menu item
dEU1b for Alarm 1 and dEU2b for Alarm 2.
The deviation band will be equal to two limits.
Display Blank A rear panel input which blanks the display
when the input is tied to logic ground by a
switch or 0V is applied (logic level true). The
meter display will light when the input is open
or is held at +5V (logic level false).
Extended Meter
A meter with an enhanced microcomputer that provides added capabilities,
such as linearization of nonlinear inputs and display of rate of change from
successive readings.
Full Scale

The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is ±20 mV (signal
range from -20 mV to +20 mV).

Function Reset
A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or 0V is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic
level false) and then set low.
Ground Loop A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual minimize ground loop problems by mutually isolating the grounds associated with
meter power, signal input, and all output and communication options.
Jumper

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure the load cell signal conditioner
board for specific full scale ranges, and to configure power supply and communications boards for various modes of operation. Unused jumpers are stored by
pushing one side over an unused post.

Hysteresis Band
A band which controls relay action symmetrically around a setpoint. The relay closes
(or opens) when the reading goes above
the setpoint plus one hysteresis limit, and
opens (or closes) when the reading falls
below the setpoint less one hysteresis limit.
A narrow hysteresis band is often used to
minimize relay chatter around a setpoint
due to electrical noise or signal feedback
caused by load switching. A wide hysteresis band can be used for control
applications, such as turning on a fill pump when the tank level has reached a
lower limit and shutting off the pump when the tank level has reached an upper
limit. The hysteresis band will be equal to two hysteresis limits.
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Menu Mode

The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

Meter Hold

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at 0V (logic level true).
The meter will resume operation when the input is allowed to float or is held at
+5V (logic level false).

Modbus

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same communication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by the meter.

Moving Average Filter
A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:
Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

Offset

A constant adder used for the displayed reading. This is the term b in the
straight line formula y = mx + b, where y is the displayed reading in counts, m
is the scale factor, x is the measured reading in counts, and b is the offset. For
direct readout in (milli)volts or (milli)amps, offset is 0.

Peak Display The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.
Rate of Change Meter
A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.
Reading

The value displayed by the meter. “Taking a reading” is the action of the meter
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.
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Remote Display
A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.
Reset

There are three types of Reset:
 Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.
 Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.
 Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved by powering up the meter, simultaneously
pressing the RESET and MENU keys, stepping through all top-level menu
choices, grounding a rear panel connector, or supplying an ASCII command. rESEt is displayed briefly.

RS485 Half Duplex
Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.
RS485 Full Duplex
Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.
Run Mode

The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

Scale

A constant multiplier used to go from A/D
converter counts to displayed counts. This is
the slope term m in the straight line formula
y = mx + b, where y is the displayed reading
in counts, m is the scale factor, x is the measured reading in counts, and b is the offset.
For direct readout in mV or mA, scale is 1.

Scaling

The process of setting scale and offset so
that the meter reads properly in engineering
units, such as lbs.

Scaling, Coordinates of 2 Points Method
A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item. If the Maximum Physical Value of the sensor exceeds 100000, the
calculated scale and offset are divided by 10 and the reading is in 10's of units.
Scaling, Scale and Offset Method
A scaling method where scale and offset are entered manually.
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Scaling, Reading Coordinates of 2 Points Method
A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.
Setpoint

A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the
setpoint.

Span

The number of counts corresponding to a given signal range.

Split Hysteresis
A hysteresis mode where a setpoint and a
single-side hysteresis limit are entered. That
limit can be negative or positive. If the limit is
negative, the relay will close below the hysteresis limit, for example to turn on a heater,
and open when the setpoint is reached. If the
limit is positive, the relay will close when that
limit is reached, for example to turn on a
cooler, and open when the setpoint is
reached. Split hysteresis is an alternative to
normal hysteresis, where the setpoint is at
the center of a symmetrical hysteresis band.
Tare

A rear panel input which causes the display to be set to zero when the input is
momentarily tied to logic ground by a switch or is held at 0V (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other applications where a reading relative to starting point is desired.

TEDS 1451.4 TEDS, or Transducer Electronic Data Sheet, is a set of electronic data in a
standardized format defined within the IEEE 1451.4 standard that is stored in
EEPROM. This data specifies what type of sensor is present, describes its
interface, and gives technical information such as sensitivity, bridge type,
excitation, etc. With TEDS Plug and Play, the sensor and the meter are automatically scaled as a system at power on.
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Valley Display
The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.
Zero

An adjustment so that a given low transducer output reads zero on the meter.
Zero is adjusted by programming offset.
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24. ACCESSORIES
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DPM-3-PC6 & DPM-3-PC12
Power Cable to Meter

DPM-3-RJ11AD9
RS232 Data Cable, PC to Meter

USB-2.0-A/B
USB Cable, Type A/B, 10 ft.

DPM-3-DLS
Data Logging Software

DPM-3-TRES
TEDS Reader_Editor Software

DPM-3-SFC
Splashproof Front Cover. Seals
meter against instrument panel.

- 51 -

25. WARRANTY & REPAIR POLICY
Limited Warranty on Products
Any of our products which, under normal operating conditions, proves defective in material
or in workmanship within one (1) year from the date of shipment by Transducer Techniques,
will be repaired or replaced free of charge provided that you obtain a return material
authorization from Transducer Techniques and send the defective product, transportation
charges prepaid with notice of the defect, and establish that the product has been properly
installed, maintained, and operated within the limits of rated and normal usage. Replacement product will be shipped F.O.B. our plant. The terms of this warranty do not extend to
any product or part thereof which, under normal usage, has an inherently shorter useful life
than one year. The replacement warranty detailed here is the Buyer’s exclusive remedy,
and will satisfy all obligations of Transducer Techniques, whether based on contract,
negligence, or otherwise. Transducer Techniques is not responsible for any incidental or
consequential loss or damage which might result from a failure of any Transducer
Techniques’ product. This express warranty is made in lieu of any and all other warranties,
expressed or implied, including implied warranty of merchantability or fitness for particular
purpose. Any unauthorized disassembly or attempt to repair voids this warranty.
Obtaining Service Under Warranty
Advance authorization is required prior to the return to Transducer Techniques. Before
returning the item(s), either write to the Repair Department c/o Transducer Techniques,
42480 Rio Nedo, Temecula, CA 92590, or call (951) 719-3965 with: 1) a part number; 2) a
serial number for the defective product; 3) a technical description of the defect; 4) a nocharge purchase order number (so products can be returned to you correctly); and, 5) ship
to and bill to addresses. Shipment to Transducer Techniques shall be at Buyer’s expense,
and repaired or replacement items will be shipped F.O.B. our plant in Temecula CA. Nonverified problems or defects may be subject to a $75 evaluation charge. Please return the
original calibration data with the unit.
Obtaining Non-Warranty Service
Advance authorization is required prior to the return to Transducer Techniques. Before
returning the item(s), either write to the Repair Department c/o Transducer Techniques,
42480 Rio Nedo, Temecula, CA 92590, or call (951) 719-3965 with: 1) a model number; 2)
a serial number for the defective product; 3) a technical description of the malfunction; 4) a
purchase order number to cover Transducer Techniques’ repair cost; and 5) ship to and bill
to addresses. After the product is evaluated by Transducer Techniques, we will contact you
to provide the estimated repair costs before proceeding. The minimum evaluation charge is
$75. Shipment to Transducer Techniques shall be at Buyer’s expense, and repaired items
will be shipped to you F.O.B. our plant in Temecula, CA. Please return the original calibration data with the unit.
Repair Warranty
All repairs of Transducer Techniques’ products are warranted for a period of 90 days from
the date of shipment. This warranty applies only to those items which were found defective
and repaired; it does not apply to products in which no defect was found and returned as is,
or merely re-calibrated. Out of warranty products may not be capable of being returned to
the exact original specifications or dimensions.
FOR TECHNICAL SUPPORT, CALL (800) 344-3965 OR FAX (951) 719-3900
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